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1 Introduction 

What’s OsiMIDI for Titan One? 

OsiMIDI for Titan One is a software that allows the use of USB MIDI controllers directly connected to USB 

ports of your PC, in order to control the Avolites Titan One / Titan Go software. 

Avolites has changed the name of the Titan One software to Titan Go in the latest versions. For simplicity, 

we will always refer to Avolites software as Titan One in this manual. OsiMIDI works with both Titan One and 

Titan Go. 

Avolites Titan is a software leader in the lighting sector, developed by the company Avolites. T1 is the 

most economical hardware for use with the Avolites Titan PC Suite. It is a USB dongle that provides a DMX 

port to your PC. However, it has the disadvantage that the user must control the software using mouse, 

keyboard, or touch screen. OsiMIDI was created to complement the T1, to allow control of Avolites software 

using USB MIDI controllers. It also works with Editor Avokey dongle. 

Starting from version 2.2, OsiMIDI also works with the T2 hardware, although with the T2 interface it is 

only possible to guarantee correct operation if MIDI controllers that have multi-client drivers are used. The 

drivers that Korg provides for its MIDI controllers are multi-client. So is the Behringer driver for the BCF2000 

controller. The generic Windows driver for MIDI controllers is not multi-client and may not work properly on 

certain computers when using OsiMIDI with T2 hardware. The T1 and Editor Avokey hardware work correctly 

with OsiMIDI with all MIDI controllers, whether they have multi-client drivers or not. 

Thus, OsiMIDI makes possible a cheap lighting control solution, composed of the following elements: 

- OsiMIDI for Titan One software. 

- T1, Editor Avokey or T2 USB dongle and Avolites Titan PC Suite software. 

- USB MIDI controller. For example: Korg nanoKontrol 2, Behringer BCF2000, Behringer X-Touch 

Compact, Elation Midicon, etc… 

Could OsiMIDI functionality be achieved with Avolites Titan MIDI Triggers? 

In the case of using the T1 dongle, Avolites software cannot be managed by a USB MIDI controller 

connected directly to a PC without the help of OsiMIDI. 

In the case of the T2 key, it is possible to use the MIDI triggers of the Avolites Titan software, however, 

OsiMIDI allows you to control a greater number of software functions. 

How does it work? 

OsiMIDI receives MIDI messages from your USB MIDI controller, and sends commands to your Avolites 

Titan One software in order to act on the configured controls. 

https://www.revers3d.com/
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Of course, OsiMIDI does not modify any of the files of Avolites Titan One software. OsiMIDI runs side by 

side with Avolites Titan and uses Windows Presentation Foundation technology to change the values of 

controls. 

Main functions 

- OsiMIDI is fully configurable and allows you to assign buttons and faders on your USB MIDI controller 

to buttons and faders on Avolites Titan One. 

The following controls on Avolites Titan One are configurable: 

• The 10 faders. 

• The 10 swop and flash buttons. 

• Back page, go to page, and next page buttons. 

• Other buttons: Record, Go, Clear, Exit..., nearly all buttons on the Titan One's interface are 

available. 

• Keyboard shortcuts. OsiMIDI can send keystrokes to Titan One to control functions that cannot be 

handled with buttons. 

• The 3 attribute wheels. 

• Buttons in these workspace windows: Playbacks, positions, colours, Groups, and Gobos and Beams. 

• Macros execution. 

Configuration is made simple thanks to capture mode available in the configuration editor. There's no 

need to enter the values manually, simply select a control on the application, and then move or click the 

equivalent control on the MIDI controller, the configurator then automatically performs the mapping for you. 

- OsiMIDI allows you to store different configurations, and then select which one you want to use. 

- OsiMIDI allows you to use up to 5 MIDI controllers simultaneously, defining their behaviour in a single 

configuration. 

- Control of motorized faders. This feature is only available starting from version 14 of Titan PC Suite. 

When using Mackie Control controllers with motorized faders, the position of the MIDI controller 

faders will always be in sync with the position of the faders in the Titan software, even when changing 

pages. 

- Pickup mode. This feature is only available starting from version 14 of Titan PC Suite. When we use 

controllers not compatible with Mackie Control, or without motorized faders, the position of the 

faders in the MIDI controller will not correspond to the position in the Titan software when we 

change the page, or if we move the faders in the software with the mouse. The pickup mode allows 

you to avoid sudden changes in the positions of the faders in the Titan software when moving the 

https://www.revers3d.com/
https://www.osimidi.com/t1


 https://www.revers3d.com 
https://www.osimidi.com/t1 

 

 6 

faders of the MIDI controller, since the fader of the controller must reach the current position of the 

fader in Titan for start moving it. 

- Remote control from a mobile or tablet through the OsiMIDI T1 Remote app. 

What USB MIDI controllers can you use? 

You can use 2 types of MIDI controllers: 

- MIDI controllers that emulate Mackie Control, like Behringer X-Touch Compact or BCF2000. These 

controllers almost always have encoders and motorized faders. 

- Generic MIDI controllers. Not always have encoders, is valid any USB MIDI controller that can send 

this type of MIDI messages: 

• Control Change or Pitch Bend for faders and knobs of type potentiometer. 

• Control Change or Note On / Off for buttons. 

• Control Change or Note On for encoders.  

For example Korg nanoKONTROL 2 wotks perfectly with OsiMIDI. 

In case of using T2 hardware, it is only possible to guarantee correct operation if MIDI controllers that 

have multi-client drivers are used. The drivers that Korg provides for its MIDI controllers are multi-client. So is 

the Behringer driver for the BCF2000 controller. The generic Windows driver for MIDI controllers is not multi-

client, and may not work properly on certain computers when using OsiMIDI with T2 hardware. The T1 

hardware works correctly with OsiMIDI with all MIDI controllers, whether they have multi-client drivers or not. 

About attribute wheels, there are two cases: 

- If your controller has encoders, you can use them to control the wheels. The encoders should operate 

in relative mode (i.e., send a message repeatedly when rotates, a different message when turning left 

or right) and send messages of type Control Change or Note On. For example, Behringer BCF 2000, 

Behringer X-Touch Compact (Control Change) and Elation Midicon (Note On) are compatible 

controllers with encoders. 

Controllers that emulate Mackie Control usually have encoders. 

- If your controller does not have encoders, such as the Korg nanoKontrol 2, you can use a knob of type 

potentiometer or a fader to control the wheels, with the help of an additional button, that would allow 

us to recover the position of the knob or fader without moving the wheel.  

Usually we will use a knob, since we will use the faders to control the Titan One faders. 

The control of the wheels using encoders provides a much better user experience than with the knobs of 

type potentiometer, since they can rotate infinitely. 

It’s possible to use up to 5 MIDI controllers simultaneously. 

https://www.revers3d.com/
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Localization 

The language of the application and help can be changed from application. The application and help are 

available in English and Spanish. 

What Avolites versions are supported? 

OsiMIDI currently supports the following versions of Avolites Titan One: 9.1, 10.x, 11.x, 12.x, 13.x, 14.x, 

15.x, 16.x and 17.x. 

Note 

OsiMIDI does not supply Avolites Titan PC Suite software nor T1 or T2 hardware. You must purchase this 

hardware and software from an official Avolites distributor. OsiMIDI neither supplies the USB MIDI controller; 

you must purchase your own. 

Avolites Titan and Titan One are registered trademarks of the company Avolites. NanoKONTROL is a 

registered trademark of Korg. BCF2000 and X-Touch Compact are registered trademarks of Behringer. Midicon 

is a registered trademark of Elation Professional. 
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2 Setup 

To install OsiMIDI for Titan One, first download the installable from the web https://www.osimidi.com/t1. 

After running the installable, we select the language of the installation, and accept the different steps of 

the wizard until the installation finishes:  
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The installation creates one shortcut on the desktop: 

 

OsiMIDI for Titan One 
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3 Software activation 

When you start the software for the first time, the software activation window is displayed: 

 

The buttons  and  in the lower left corner allow you to change the language of the window to 

Spanish or English. 

3.1 Activate using a serial number 

If you have a serial number, you can activate the application by clicking on the "Activate using a serial 

number" button: 

 

The license activation dialog will be displayed, in which you must enter the serial number, and then 

click on the "Activate license" button: 

 

To activate the software, it is necessary to have an internet connection. 

https://www.revers3d.com/
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3.2 Test in demonstration mode 

If you want to test the application before purchasing a license, you can activate it in demo mode. Demo 

mode allows you to test the application for free during 30 days. 

The only limitation of the demonstration mode is that the application disconnects from the Titan One 

software after 5 minutes of use, being necessary to wait 1 minute to reconnect again. 

To activate the demo mode, you must click on the button "Try in demonstration mode for 30 days": 

 

To activate the demonstration mode, it is necessary to have an internet connection. 

Once the 30 days of the demonstration period have expired, it is necessary to acquire a license to 

continue using the product. 

3.3 Buy OsiMIDI for Titan One 

To acquire a license, you must navigate to the product website https://www.osimidi.com/t1. You can 

navigate to the product website by entering the URL in the browser, or by clicking on the "Buy OsiMIDI for 

Titan One" button: 

 

Once you are on the product website, you can use the "Prices" menu, available in the top bar, to move 

to that section, where you can start the purchase process, both individual licenses and license packs. 

License packs allow you to purchase more than one license in a single purchase, at a lower cost per 

license. The greater the number of licenses that make up the pack, the great the discount obtained.  

https://www.revers3d.com/
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4 Application user interface 

4.1 Starting the application 

To open the main application of OsiMIDI for Titan One you must use the shortcut created during the 

installation process: 

 

OsiMIDI for Titan One 

OsiMIDI for Titan One detects the MIDI controllers during the start-up process, so it is necessary to have 

them connected to the PC before opening the application. 

4.2 Main window 

Once the application is started the main window is displayed: 

 

You must select the configuration you're going to use from the "Configuration" dropdown. This 

dropdown lists all the configuration we have created with the configuration editor. 

Once the working configuration is selected, a group of controls "MIDI Controllers" will be shown. It will 

display a row for each MIDI controller defined in the configuration. In each row, a label will show us the name 

that we assigned to the MIDI controller when created the configuration, and in the dropdown you must select 

the corresponding MIDI device. In case the MIDI device has the same name as when the configuration was 

created, it will be selected automatically (sometimes the Windows operating system renames USB MIDI 

https://www.revers3d.com/
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devices if you connect them to a different USB port, or if you update the driver). The following image shows 

the main window in which a configuration with two MIDI controllers was selected: 

 

The option "Enable pickup mode" allows you to enable this function, which we will comment in next 

section. 

Once all the options have been selected, you can click on the "Start" button, and start listening for 

messages from the devices. OsiMIDI will start listening to the messages from the MIDI controllers, allowing 

them to control the Titan One application. 

For the correct operation of OsiMIDI, it is essential to start the Titan One application completely before 

clicking on the “Start” button. 

 The "Stop" button allows you to stop controlling the Titan One application with the MIDI controllers. 

All communications with the MIDI controllers will stop. 

4.3 Pickup mode 

This option enables pickup mode for controllers that do not have motorized faders. Normally the 

controllers that emulate Mackie Control have motorized faders, so this option is usually useful for standard 

MIDI controllers, type Korg nanoKontrol or similar. 

When we use controllers without motorized faders, the position of the faders in the MIDI controller will 

not correspond to the position in the Titan software when we change the page, or if we move the faders in 

the software with the mouse. The pickup mode allows you to avoid sudden changes in the positions of the 

faders in the Titan software when moving the faders of the MIDI controller, since the fader of the controller 

must reach the current position of the fader in Titan for start moving it. 

This functionality is only available for Titan PC Suite 14. 

https://www.revers3d.com/
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4.4  “File” menu 

The following image shows the "File" menu of the application: 

 

By opening the "File" menu, we have access to the “Exit” command, which allows us to close the 

application. 

4.5 Configuration editor 

Before using OsiMIDI Stage, it is necessary to configure the application to map the faders, knobs and 

buttons of the MIDI controllers to Titan One functions. 

To do this you will use the OsiMIDI configuration editor. Although editing mode allows you to enter the 

values manually, the simplest way to perform the configuration is using the capture mode. In capture mode, 

you select controls on the configuration editor and then act on the corresponding control of the MIDI 

controller. The configuration editor detects the MIDI message data, and assigns it to the selected control on 

the application. 

In the following sections describe the configuration editor will be explained in detail. 

4.5.1 Opening the configuration editor 

To open the configuration editor, you will use the command “Open configuration editor” 

. 

The following image shows the main window of the configuration editor: 

https://www.revers3d.com/
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The main window of the configuration editor consists of 5 main zones: 

1. Window title. 

2. “File” menu. 

3. Ribbon, with commands to edit the configuration. 

4. Main area. It displays the configuration in edition, with the MIDI values corresponding to each one 

of the controls. 

5. Status bar, only visible when we are editing a configuration. Informative messages about the use of 

the configuration editor, as well as warnings and errors, are displayed in the status bar. 

When opening the configuration editor, a text in the main area informs you that you do not have a 

configuration in edition.  

Using the “File” menu, we can open an existing configuration to edit it, or create a new one. It also 

allows us to import and export configurations. 

4.5.2 Window title 

The title of the configuration editor window shows the following information: 

 

1 

 

2 

 

4 

3 

 

5 
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- Product name: OsiMIDI for Titan One. 

- Application version. 

- Name of the configuration currently in edition, in square brackets. 

- If any changes have been made to the configuration currently in edition, and have not been saved, 

an asterisk (*) will be displayed to the right of the title. Asterisk will disappear after saving the 

configuration. 

4.5.3 “File” menu 

The following image shows the “File” menu of the configuration editor: 

 

4.5.4 New configuration 

We can create as many configurations as we want. If we have several models of MIDI controllers, we 

can create a configuration for each of them, or for groups of controllers, combinations of them. 

To create a new configuration, click on the  button available in the “File” 

menu. The following dialog will be displayed: 

https://www.revers3d.com/
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In the field “name” you must enter the name that you want to give to the configuration. The 

configuration name must be unique, you can’t create two configurations with the same name. 

Below the name field, in the left column, there’s a group of controls "Devices", where a list with the 

MIDI controllers of the configuration is shown. 

In the field “Number of MIDI controllers” you must enter the number of controllers that will be part 

of the configuration, can be a value between 1 and 5. 

Next you will have to introduce the data of each one of the controllers. For that, you must select the 

controller in the list, and then you can modify its properties in the panel of the right column “Properties of 

MIDI controller”: 

- Name. You must enter a name for the controller. 

- Model. You must select “Mackie Control controller” if your controller is working in Mackie Control 

emulation mode, or "MIDI controller" otherwise. 

- Input device and output device. Select the MIDI device in the dropdowns. 

- Motorized faders. This functionality is only available for Titan PC Suite 14. When using Mackie 

Control controllers with motorized faders, the position of the MIDI controller faders will always be 

in sync with the position of the faders in the Titan software, even when changing pages. 

- Ignore channel. Available if you have selected “MIDI Controller” as the model. If you check this 

option, the channel of the messages sent by the MIDI controllers will be ignored. It has been added 

for compatibility with previous versions, to be able to import configurations of OsiMIDI 1.8 or 

earlier. The usual is to leave this option unchecked, since there are MIDI controllers that need to 

take the channel into account in order to work properly. 

https://www.revers3d.com/
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- Operating mode. Korg nanoKONTROL 2 and nanoPAD 2 controllers can work in 2 operating modes, 

native mode and normal mode: 

o In native mode, the configuration of the MIDI controller in OsiMIDI is easier, since the native 

mode involves pre-configured messages that work correctly with OsiMIDI. In native mode it is 

not possible to use the scenes of the MIDI controller. 

o In normal mode, it's possible to configure the messages of the MIDI controller with the Korg 

KONTROL Editor software, and the scenes of the MIDI controller can be used. 

Unless you need to use the MIDI controller scenes, we recommend you always use the native 

mode. 

- Color. Automatically defined, is the color that will identify the controller in the main area of the 

configuration editor. 

At any time, you can remove the last controllers from the list, reducing the value “Number of MIDI 

controllers”, or deleting the selected controller with the "Remove MIDI controller" button. 

Once the dialog is accepted, the new configuration will be displayed in the main area of the 

configuration editor to continue editing. The name of the configuration will be displayed in the title of the 

application. 

4.5.4.1 Controllers colors 

A color is assigned to each controller in the configuration. In the new configuration window, the color 

of each of the configured controllers is displayed. These colors will be used to identify which device has been 

mapped to each of the functions of the configuration in edition, in the main area of the configurator editor. 

Next, the new configuration dialog is displayed, with the maximum number of controllers set, to show 

the color palette that will be assigned to the controllers: 

https://www.revers3d.com/
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4.5.4.2 Enable connection to the OsiMIDI T1 Remote app 

The OsiMIDI T1 Remote app is an app developed for iOS and Android mobile devices, which allows 

you to control OsiMIDI T1 remotely. 

To enable the connection to the OsiMIDI T1 Remote app, we must mark the check "Enable 

connection to the OsiMIDI T1 Remote App". 

 

It is also necessary to set a listening port, by default the default port in both OsiMIDI T1 and the app, 

is 14415. In principle it is not necessary to modify it unless this port is already being used by another application 

https://www.revers3d.com/
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on the computer. If the port is modified in OsiMIDI T1, it will be necessary to modify it also in the OsiMIDI T1 

Remote app, setting the same value. 

The connection between the app and OsiMIDI is made through the OSC protocol. 

4.5.4.3 Enable connection to other OSC applications 

OsiMIDI T1 can be controlled by other third-party applications compatible with the OSC protocol. 

To enable OSC connection with third-party applications, we must mark the check "Enable OSC for 

other applications". 

 

It will be necessary to specify one or more OSC destinations, the usual thing will be to establish one. 

The OSC target defines the IP and listening port of the third-party OSC application. In this way OsiMIDI will 

send messages to OSC targets, for example, when the position of a fader is changed from Titan Go or from a 

MIDI controller. 

To create an OSC destination we will use the button . The following dialog will be 

displayed, in which the IP and port of the OSC destination will be entered, and a description. 

https://www.revers3d.com/
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Once an OSC target is created, it will be displayed in the listing.  

 

The  and  buttons allow you to edit and delete an already created 

OSC target. 

Once the configuration is created, the OSC addresses corresponding to each control can be displayed 

in the configuration editor, selecting the "OSC server" device tab. 

4.5.5 Open configuration 

To open an existing configuration, click on the  button, available in the “File” 

menu. 

https://www.revers3d.com/
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The following dialog will appear, which allows you to select one of the existing configurations. When 

you accept the dialog, the selected configuration is displayed in the main area of the configuration editor, on 

which you can edit it. The name of the open configuration will be displayed in the application title. 

 

 In case you have not yet created any configuration, the following message will be displayed, which 

gives you the possibility to create a new configuration: 

 

4.5.6 Export configuration 

The   button in the “File” menu allows you to export one or more 

configurations to a file, which can be imported later on the same computer or on a different computer, with 

the import configuration function. 

After clicking the button, the following dialog is displayed, in which you can select which configurations 

you want to export, from the existing ones: 

https://www.revers3d.com/
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Once the dialog is accepted, a second dialog will be displayed, in which you will define the location 

and name of the export file. Then the file with the exported configurations (.export) will be generated. 

4.5.7 Import configuration 

The button  in the “File” menu allows you to import configurations 

previously exported to a file. 

When you click the button, a dialog will appear in which you will select the file with the configurations. 

Subsequently a second dialog will allow you to select which configurations of the file you want to import: 

 

4.5.8 Import configurations from a previously installed OsiMIDI (1.8 or older) 

By default, OsiMIDI 2.0 does not import the existing configurations created with older OsiMIDI 

versions automatically, they must be imported manually. 

https://www.revers3d.com/
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The button in “File” menu 

allows you to import existing configurations from an installation of an older version of OsiMIDI (1.8 or 

previous). 

When you click the button, a dialog will appear with the existing configurations, where you must select 

what configurations you want to import: 

 

This button is visible only if configurations from a previous installation of OsiMIDI 1.8 or older exists. 

4.5.9 Exit 

It is the last button in the “File” menu, it allows you to close the configuration editor. 

In case you have a configuration in edition and you have not saved the changes, a message will be 

displayed, indicating that if you continue to leave the configuration editor the changes made will be lost, and 

offering you the possibility to save the configuration or cancel the operation: 

 

4.5.10 Configuration edition 

Once a configuration is loaded, it is displayed in the main area of the configuration editor: 
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 The buttons on the ribbon allow you to edit the loaded configuration. 

The configuration in edition is shown distributed in six tabs: “Faders”, “Buttons”, “Keyboard 

shortcuts”, “Wheels”, “Workspaces” and “Macros”. The tabs contain different controls, which represent the 

controls of MIDI controllers: buttons, faders and knobs. Each control also represents a function of Titan One. 

The tabs of the configuration are contained in device tabs, there being one tab per device defined in 

the configuration.  

4.5.10.1 Device tabs 

The device tabs have the color assigned to the device in the configuration. 

 

Configuration controls can be mapped to more than one device simultaneously. In the lower right 

corner of each control, coloured rectangles indicate with which devices has been mapped to that control (the 

color indicates the device). The following image shows a button mapped with two devices. 
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The color of the border around the control indicates to which device correspond the values that are 

being displayed. 

In simulation and capture modes, the mappings of all the controls that have been configured with a 

single device are shown. The border of the control will have the colour of the mapped device. In the case of 

controls mapped with more than one device, the displayed values correspond to the device of the selected 

device tab. We can select other device tab to give priority to the visualization of the data of that device. 

 

In edit mode, only the maps corresponding to the device of the selected device tab are displayed. 

This allows you to add maps corresponding to the selected device manually using the “Edit values” function. 
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4.5.10.2 Faders 

This tab allows you to map the Titan One faders, as well as the Swop and Flash buttons. It also allows 

you to map the paging buttons: “Page down”, “Goto page”, and “Page up”. 
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4.5.10.3 Buttons 

This tab allows you to map additional buttons of Titan One. 

 

  

https://www.revers3d.com/
https://www.osimidi.com/t1


 https://www.revers3d.com 
https://www.osimidi.com/t1 

 

 30 

4.5.10.4 Keyboard shortcuts 

OsiMIDI allows you to send keyboard shortcuts to Titan One, since they are additional functions not 

available in buttons. In the configuration, the shortcuts behave exactly like the buttons. The only difference is 

that for keyboard shortcuts OsiMIDI will send keystrokes to Titan One instead of clicking on buttons. 
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4.5.10.5 Wheels 

OsiMIDI allows controlling the 3 attribute wheels: 

 

In the "Wheels" tab you have 3 groups of controls, each one allows you to configure one of the wheels. 

In each group of controls, you have a combo box that lets you select the operating mode of each 

wheel, from between the two available: 

- Encoder knob (Relative). You will use this mode if you have a USB MIDI controller with encoders. 

It is the recommended control mode, since the encoders can rotate infinitely. 

- Potentiometer knob / fader (Absolute). We will use this mode if our USB MIDI controller does not 

have encoders. In this case OsiMIDI allows us to control the wheels with a potentiometer knob or 

with a fader, with the help of an additional button that will allow us to recover the position when 

we reach the end of the knob or fader path, preventing the movement of the wheel in the 

opposite direction. 
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4.5.10.5.1 Encoder knob mode (Relative) 

You use this mode if your controller has endless rotary controls (encoders) that operate in relative 

mode. 

Encoders operating in relative mode send a MIDI message repeatedly when rotated, the message 

changes depending on whether you turn the encoder left or right. OsiMIDI supports Control Change and Note 

On type messages for encoders. For example, if you have a Behringer BCF 2000 controller you should configure 

it to send messages of Control Change type in “Relative 1” mode. Elation Midicon controller sends Note On 

messages, which are also compatible with OsiMIDI. 

Each group of controls has two buttons: “Left” and “Right”. These buttons do not actually exist on 

your MIDI controller, it is a model that allows us to represent the encoder and set the MIDI message sent by 

your controller when the encoder turns left or right. Like any other control, you can configure these messages 

manually, or with the help of capture mode. 

 

To configure an encoder in capture mode, click on the “Left” control of the corresponding wheel, 

and then turn the encoder to the left on the MIDI controller. The message sent by the encoder while rotating 

to the left is captured. Then click on the “Right” control and turn the encoder to the right on the MIDI 

controller. The message sent by the encoder while rotating to the right is captured. You must proceed in the 

same way to configure the other wheels. 

4.5.10.5.2 Potentiometer knob / fader mode (Absolute) 

What happens if your controller does not have encoders, can’t you control the wheels? Yes, 

OsiMIDI allows you to control the wheels in this case using a potentiometer knob or a fader, with the help of 

an additional button.  

Why do you need the help of an additional button? Suppose you use a potentiometer knob to move 

one of the wheels. You move the knob until you reach the end of its path, but you want to continue turning 

the wheel in Avolites. Here comes the "Wheels disable" button in your help, while pressing this button the 

wheel does not turn, even if we move the knob. So, you press the button, and at the same time you move the 

knob in the opposite direction. The wheel has not rotated and you have recovered position. Now release the 

button and move the knob again so that the wheel continues to turn in the desired direction. 
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To configure the wheel in this mode "Knob potentiometer / fader (Absolute)", you have to map the 

"Wheels disable" button, and the knob or fader with which you will control each of the wheels. 

4.5.10.5.3 Control wheels 1 and 2 with Pad XY (Pan and Tilt) 

OsiMIDI allows to control wheels 1 and 2 with a Pad XY, if we have a controller with this element. 

This is useful for controlling Pan and Tilt using the surface of the Pad XY. 

The easiest way to configure the Pad XY is by using the capture mode. In capture mode we have a 

“Capture values” button, which opens the Pad XY configuration wizard, and an “Erase values” button, which 

deletes the Pad XY configuration. 

 

The Pad XY configuration wizard informs us that we must press the different corners of the Pad XY, 

after which the Pad XY will be configured. If you are using a Korg nanoPAD2 controller in native mode, simply 

press one of the corners of the controller, since in native mode the nanoPAD2 messages are predefined by 

the manufacturer. 
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4.5.10.5.4 Sensitivity wheel adjustment 

OsiMIDI does not have a sensitivity wheel adjustment, as it is possible to set the sensitivity of the 

wheels from the own Titan One software (Avo \ User Settings \ Wheels sensitivity). 

 

Don’t forget to release the Avo button, as if it remains pressed wheels work always with very high 

sensitivity. 
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4.5.10.6 Workspaces 

OsiMIDI allows you to control the first 100 buttons of the following workspace windows: Groups, 

Colours, Position, Gobos and Beams, and Playbacks. 
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4.5.10.7 Macros 

OsiMIDI allows you to map macros to MIDI controller buttons, using the "Macros" tab. The number 

of each of the buttons in the "Macros" tab indicates the macro number that will be executed when you press 

the button mapped on the MIDI controller. The function that will be executed when pressing the button 

mapped on the controller is equivalent to pressing the "Macro" button on Titan One, entering the macro 

number with the keyboard, and pressing the "Enter" key. 

 

4.5.11 Edit name and controllers of the configuration 

The button  allows to edit the general aspects of the configuration: The configuration 

name and the controllers that are part of the configuration. 

Clicking on this button displays the configuration edit dialog, identical to the one used when creating 

a new configuration. 

If the option "Ignore channel" is modified in a MIDI controller, all existing values in the configuration 

for this controller will be deleted. Ignore channel is always disabled when selecting a Mackie Control emulation 

model. 
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4.5.12 Erase all values of the configuration 

The button  allows us to delete all the data of a configuration, leaving it blank, as if 

we had just created it. 

We will be asked to confirm the operation: 

 

4.5.13 Delete configuration 

To delete a configuration, first you must open it, and once opened you can delete it by clicking on the 

 button. 

A confirmation message will be displayed before execute the operation: 
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4.5.14 Configurator working modes 

The configurator has 3 working modes: Simulation mode, capture mode and edit mode. We can switch 

to a specific working mode by clicking on the corresponding button: 

4.5.14.1 Edit mode 

To enter into edit mode, press the  button. It is a manual editing mode.  

In edit mode you can select the controls of the main area by clicking on them. Once you have selected 

a control, you will see it highlighted in blue, as it is observed in the following image: 

 

 Once you have a control selected, the  and  buttons are enabled, which allow you to 

edit and delete the mapping values of the selected control respectively. 
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Clicking on the button  will display the following dialog, which will allow you to enter the 

mapping data of the selected control: 

 

 The MIDI controller is not modifiable, it corresponds to the MIDI controller of the currently selected 

device tab. 

The values of address, value off, value on and note will always be entered in hexadecimal. 

 Once the control values are entered, they will be displayed inside the control. In addition, once a 

control has been mapped with a MIDI controller, the edge of the controller is marked with the color assigned 

to that controller. The left edge has made thicker so that the color of the controller is more visible. 

 

The values shown correspond to the following information, from top to bottom: 

- Type of message, in black color: CC (Control Change), PB (Pitch Bend), NOO (Note On / Off). 

- Channel, in red color. 
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- Address or note, in brown color. 

- Off value, in green color. 

- On value, in blue color. 

4.5.14.2 Capture mode 

It is activated by pressing the  button. This is the preferred mode for mapping the various 

configuration controls 

In capture mode it is not necessary to enter values manually. Simply select a control on the working 

area, and activate the corresponding control on the MIDI controller. The configuration editor will capture all 

MIDI message values automatically: 

- In the case of a button press the button on the MIDI controller. 

- In the case of a fader move it completely to the minimum position and to the maximum position. 

It is important to perform this movement several times, to ensure that OsiMIDI captures the MIDI 

values of the minimum and maximum positions. 

- In the case of knobs, the mapping is done differently depending on whether it is an encoder 

(relative) or a potentiometer (absolute): 

o Encoder (relative). It is displayed on the configurator as 2 buttons. To map an encoder, select the 

button on the left, and move the encoder slowly to the left. Then select the button on the right, 

and move the encoder slowly to the right. It is important to move it slowly, since there are MIDI 

controllers that reflect the speed we turn the encoder in the MIDI values. 

 

o Potentiometer (absolute). In the case of a potentiometer, will turn it completely to the left and 

then completely to the right. It is important to perform this movement several times, to ensure 

that OsiMIDI captures the MIDI values of the minimum and maximum positions. 
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4.5.14.3 Simulation mode 

The simulation mode is the default mode when you create or open a configuration. 

When you are in another working mode, you can return to the simulation mode by clicking on the 

button . 

In simulation mode, it is not possible to edit the configurations. It is used to verify that the entered 

values are correct. In simulation mode if you press a button on the MIDI controller, the mapped button in the 

configuration will be highlighted. Similarly, if you move a fader on the MIDI controller, the corresponding fader 

will move in the configurator application. If you rotate a knob in the controller, it will rotate in the 

configuration application.  

When you action a control on the MIDi controller, the tab of the configuration containing the button 

or fader, will be automatically selected, as well as the corresponding device tab. 

4.5.15 Save 

At any time you can store the modifications made in a configuration using the button . When 

you have made changes and they have not been saved, a * will be displayed to the right of the title title of the 

window. 

At the time of saving it will be verified that there are not more than one control with the same MIDI 

address. If there are several controls with the same mapping, a message will be displayed indicating that the 

configuration can not be saved. The user must correct the configuration so that the configured controls have 

unique mappings. Controls with equal mappings will be highlighted in red. 

In addition, configuration errors will be displayed in the status bar at the bottom of the window. The 

button "Go to the next error" allows you to move the selection between the controls with errors, to locate 

them in the configuration in a simple way. 

Devices that have controls mapped with errors will also show an error icon on the corresponding 

device tab. 
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4.6 Language selection 

You can modify the language of the application from the tab "Language" of the ribbon, pressing the 

button corresponding to the desired language: 

 

Available languages are: Spanish and English.  

Selecting a language modifies both the language of the application and the manual. 
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4.7 Activating the application 

In case you were using the application in demonstration mode, and you have acquired a license, you 

can activate the license using the  button available the "Help" tab: 

 

To activate OsiMIDI, you must enter the serial number in the text box and click on the "Activate license" 

button. 

 

To activate the license is necessary to have internet connection. 

4.7.1 Return license to server 

One serial number allows to activate OsiMIDI for Titan One on a single computer at a given time. Once 

OsiMIDI has been activated on a computer with a serial number, it is not possible to activate OsiMIDI on 

another computer using the same serial number at the same time. 

If you need to use OsiMIDI for Titan One on more than one computer at the same time, it is necessary 

to acquire more than one license. 

However, it is possible to move the license from one computer to another, that is, remove the license 

on one computer by returning it to the server, in order to activate OsiMIDI later on another computer. 

For this you must open the license dialog. You are informed that the application is registered, and 

the serial number is displayed: 
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To return the license click on the button "Return license to the server”. 

 

Once the license is returned to the server, it is possible to activate OsiMIDI on another computer. 

To return the license to the server, it is necessary to have an internet connection. 

4.8 Manual 

The  button on the "Help" tab opens the user manual. 
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4.9 DEMO mode 

When you are using the application in demonstration mode, you have 30 days to try the product. 

In the main window an information message will be shown indicating the days that are left of use in 

demonstration mode. The message also informs that in demo mode the application will be disconnected from 

the Titan One software after 5 minutes of use, being necessary to wait 1 minute to reconnect again. 
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5 Requirements 

OsiMIDI supports the following Windows operating system versions: 7, 8.x, 10 and 11. 

OsiMIDI supports the following Avolites Titan One versions: 9.1, 10.x, 11.x, 12.x, 13.x, 14.x, 15.x, 16.x and 

17.x. 

6 Customer support 

OsiMIDI is a software developed by REVERS3D Software SL. 

You can get support contacting us by email at info@osimidi.com, or using the contact form in our website 

https://www.osimidi.com/t1.  

We also give customer support at Facebook https://www.facebook.com/OsiMIDI/. 
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